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1 Importing JSF Files into SonarWiz 

This technical note describes the recommended technique for importing Edgetech JSF 

files containing sidescan or sub-bottom sonar data into a SonarWiz project. 

1.1 Importing JSF sidescan data 

1. Create a project as you normally would. 

2. Use the File->Import Sidescan Sonar Files dialog. 

a. Select the file you would like to import and then click on the File Specific 

Options Button as shown below: 

 

 
b. In the File Specific Options window select the Edgetech JSF tab and set 

the gain settings as indicated above.  You may need to increase or 

decrease the TVG value but starting with 50dB/100m is a good first 

estimate.   

c. Set the Import Gain to No Gain.  Uncheck the Enable Thresholding 

checkbox.  Uncheck the AutoTVG checkbox. 

3. Import the file as usual.  When the import completes look at the file in the bottom 

tracker window and verify that the data is approximately what you want.  If the 
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data in the nadir area is too bright or too dark then open the Import Sidescan 

dialog again and go into the Edgetech settings again and adjust the TVG setting.  

Don’t worry if the data looks good in the nadir but is weak in the far ranges—you 

can correct the data once you have it imported.  The important thing is to get the 

nadir region imported so that it is as bright as possible without clipping.  Again, 

the File Specific Options->Edgetech JSF->TVG setting is the way to control this.  

You will likely find that the higher frequency 4200 and 4125 sonars will require a 

higher TVG values.  For example, on the 1600kHz 4125 sonar it is not 

uncommon to use values of 120db/100 meters.  For the 400kHz 4125 values of 

around 50dB/100 meters work well. 

 

4. The example below is 1600kHz data and looks good with a 130dB/100m setting: 

 

 
5. The example below is 900kHz data and looks good with a 30dB/100m setting: 
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6. The example below is 100kHz data and looks good with a 40dB/100m setting: 
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7. Regardless of what gain you use to import the data, the next steps are Bottom 

Track and Apply EGN and they must be done in that order. 

 

 

1.2 Importing JSF sub-bottom data 

1.2.1 Choose Sub-bottom import POLARITY 

For versions 6.04.0001 and later, this is a mandate - set the import DATA POLARITY 

choice to be the same as the data in your file - it may be bipolar or unipolar. Use the 

PROPERTIES button to find out which: 

 

The most common polarity for Edgetech JSF files is unipolar.  

1.2.2 Choose Sub-bottom FileTypeSpecificOptions 

For versions 6.05.0002 and later: For sub-bottom data, use the same techniques, but 

use these for FileTypeSpecificOptions: 
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SB import in 6.05.0002 and later: The reason you need these settings cleared, is that 

sub-bottom internal data format upgraded in 6.05.0002 to a new high-precision full-

resolution 32-bit floating-point database storage format, but you may interfere with the 

import if you set these checkboxes. Just leave them all EMPTY and the import will go 

well, then open a COLOR WINDOW and select SUB-BOTTOM CH1. for Data Type, and 

click SCALE TO DATA, and you should see a good wide numeric range and a 

histogram like this: 
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(Color window described in more detail in section 3). If you see a data range like 0.0 - 

1.0 then go back and clear the FileTypeSpecificSettings checkboxes like AutoTVG, 

AutoScale and the like (see example 2 figures up). 

2 General  JSF Import ideas for both sidescan and sub-bottom 

2.1 Using various manually selected values for JSF scalar 

For sub-bottom import, versions 6.05.0002 AND later: Clear all checkboxes in this 

area in the JSF FileTypeSpecificOptions: 
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For sidescan data (any SonarWiz 6 version), or sub-bottom versions 6.05.0001 

and EARLIER: The range of values in the JSF Scalar are 0.001 to 10,000.00. You can 

select to import with a manually selected value and get incredible differences in import 

results, depending upon the value selected.  

A good technique is to try values like 1, 100, 250, 500, 1000, 2500, 5000, 10,000. 

We’ve actually seen some files where the best value is a manually selected value less 

than 1, like 0.01, so be sure to try a range of values like this as you experiment. 

2.2 Coordinating JSF SS gains in a File Import Sequence 

For sidescan import: If you are a using newer  SonarWiz version, you may be able to 

take advantage of this feature, added in 5.06.0042, in December, 2013. The "Update 

Min/Max Amplitude" checkbox is one you should have checked, on the first JSF file to 

be imported, in a sequence. If the import looks good, then UNCHECK the checkbox, for 

importing subsequent files. The values used during the first file import will be used 

instead. In this way, you create a homogeneous effect on the import for all files in the 

sequence.  
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In explanation, Edgetech pointed out that when importing multiple JSF files there would 

be some amplitude scaling differences between the files.  The reason is that SonarWiz 

computes some min /max amplitude values for each file as its imported.  These values 

are used in the amplitude scaling of CSF files.   If the min /max values are computed for 

each file then it's possible that each file could be scaled slightly different.   To remedy 

this problem we added the "Update Min/Max Amplitude" check box to the JSF file 

specific dialog, to give the customer complete control over it. You may  instruct 

SonarWiz to either compute new Min/Max amplitudes (e.g. on the first file),  or to use 

the previously computed values (e.g. on subsequent files). So the technique is to load 

the first file with the check box on and then subsequent files leave it off. 
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2.3 Selecting JSF Navigation (position) Source 

2.3.1 Choosing Source (fish) Coords vs Group (ship) Coords 

The Source Coords vs Group Coords choice can affect import, such as if the file only 

had Group Coords navigation data stored, and you select Source Coords, then the file 

would not import properly (6.05.0004 and earlier versions). If you get an error as if the 

file contains no navigation data when imported, be sure to try the other setting.  

 

Another aspect of this to consider, is that if you have both Source and Group 

coordinates in a JSF file, they may have been changing at different rates, and may have 

different levels of precision - i.e. they may be very different and one may be preferred. 

Some users have suggested that GROUP coordinates are always to be preferred.  
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2.3.2 6.05.0005 and later versions - Navigation Import Choices and Errors 

In SonarWiz 6.05.0005, importing JSF files is easier! If your file contains no navigation, 

it will immediately show this error in the OUTPUT MESSAGE LOG during import: 

 

If your files contains only ONE source of navigation, like SOURCE (fish)-only, or 

GROUP (ship)-only, and you selected the WRONG one, SonarWiz will automatically 

import the other, but will let you know with a GREEN message in the OUTPUT 

MESSAGE LOG, like this: 

 

That JSF file was injected using NavInjectorPro, using SHIP-ONLY injection, so it 

contains only GROUP coordinates. The file import had selected SOURCE as the 

choice, in JSF FileTypeSpecificOptions: 

 

As a result of the automatic choice switching, SonarWiz also resets the CHOICE in the 

FileTypeSpecificOptions, assuming the remainder of the JSF files to be imported are 

similarly populated with GROUP (ship) navigation only.  
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2.3.3 Example comparison of SOURCE and GROUP coordinates import 

These numbers are created by TOOLS -> CSF -> Extract CSF to CSV file, after project 

level Time Constant for Course Smoothing = 3, and the same JSF file was imported the 

two different ways: 
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and 

 

The numbers are definitely different, and you can see the results in a navigation plot line 

on the mosaic. Be sure to decide for yourself which you prefer.  

2.3.4 Choosing the NMEA Coordinates Option 

You may find too, that in a rare case, the better choice to present your lines is to select 

NMEA Coordinates: 



ImportingJSFFiles.PDF Chesapeake Technology, Inc. copyright 2016-2017 

Rev 14, 5/25/2016 support@chesapeaketech.com 650-967-2045 Page 15 
 

 

In the JSF file the NMEA coordinates are not actually part of the sonar record (Type 
80).  The SonarWiz extraction utility though (Tools -> JSF -> Extract JSF navigation) 
displays them as NMEA Lat/Lon/Height, as this utility was designed to show users 
which navigation sources are available in a JSF file.   
 
The NMEA GGA records recorded by Edgetech DISCOVER are stored in a different 
record in the JSF file (Type 2002) and occur much less frequently then the sonar ping 
records.  You can see this below by using the Edgetech Show JSF utility which we 
describe in CTI Training classes: 
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The SonarWiz JSF extraction utility simply displays the last received NMEA lat/lon in the 

CSV file each time it writes out the ping record, so the NMEA position in this CSV file 

may not match the ping position exactly.    

2.4 JSF Channel Choices affect Import 

In the OPEN dialog you can select which channels of your JSF file to import, e.g. chs 1 

and 2 or chs 3 and 4. The data are sometimes stored with low frequency in channels 

1,2 and high frequency in channels 3,4, if you have a 4-channel recording.  

If you try to import the file and get an error message saying no CSF file is create, no 

records of the file match input criteria – chances are you are asking to import channels 

1 and 2, and the usable data are actually stored in channels 3 and 4. Be sure to try both 

options in case the JSF file was created with some empty channels.  
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2.5 Signal Component Choice 

Some users distinguish between real, imaginary, and envelope in the JSF processing. If 

this choice is important to you, please read this section for extra detail about the choice, 

and how it can affect your post-processing.  

The JSF file-type-specific options for import provide this radio-button choice: 

 

The options are described in the SonarWiz 5 User Guide section 5.3.2.4, but there is 

additional detail here. 

The post-processing is affected both by your choice here, and what types of JSF 

packets were stored in the JSF file, which you are importing. Here are some issue to 

consider: 

The Edgetech documentation that we are working by actually lists 9 different 

possibilities for storing samples in the JSF record. A “short” below means a 16-bit sized 

INTEGER format variable in the software.  A “float” is a floating-point representation 

code. 
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DataFormat 

Code 

Storage Format in the JSF File 

0 1 short  per sample  - envelope data                              

1 2 shorts per sample  - stored as real(1), imaginary(1)               

2 1 short  per sample  - before matched filter (raw)                

3 1 short  per sample  - real part analytic signal                  

4 1 short  per sample  - pixel data / ceros data                    

5 1 byte   per sample  - pixel data                                 

6 1 long   per sample  - raw data                                   

7 2 floats per sample  - stored as real(1), imaginary(1),                

8 1 float  per sample  - envelope data                              

Here’s how the post-processing depends both upon your choice of signal component, 
but also what data is actually stored in your JSF file: 

(1) If the JSF data you are importing contains complex pairs (format 1 or format 7) 
then, SonarWiz will honor your selection of real versus imaginary versus 
envelope.  If the JSF sample is format 1 or format 7 and you select 'envelope' 
then SonarWiz returns the sqrt(I^I + Q^Q). (IMPLIED: If data format code 0 or 8 
is all that’s in your JSF file, the Signal Component choice has no effect, and all 
you will get is envelope data in post-processing). 
 

(2) If the JSF file contains format 3 (real part analytic) then that data is used as is 
with the scalars you've set. 
 

(3) Of course, if the input JSF file does not contain either complex or real analytic 
data SonarWiz can't create it.  The first step is to understand what format was 
stored into your JSF by the acquisition software, The older Discover software 
used INI files to configure the data format that was stored in the JSF, but with 
more current versions of Discover, it might be controlled differently. 

2.5.1 Seeing your Stored JSF File Data Format Information 

To view what types of data format codes are defined per ping in the JSF file you are 
importing, use the TOOLS -> JSF option to export the JSF navigation and data format 
information to a CSV file (comma separated values). This is a type of file easily viewed 
in TEXT format via EXCEL or NOTEPAD, for example, as opposed to the binary JSF 
file format. Once you see what is stored in your JSF file, you can make a more informed 
choice for Signal Component, to use for your post-processing.  

The SUBSYSTEM column tells you whether you have SIDECSCAN ON LY (e.g. values 
20 and 21), or SUB-BOTTOM (e.g. value 0) data stored in the file. This is defined in the 
JSF Files Format Specification p. 5, like so: 
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Example JSF file read-out to CSV file: 

 

So this file contains 5 channels of data: 

 Low frequency channels 1/2 (sidescan) = subsystem 20 

 High frequency channels 3/4 (sidescan) = subsystem 21 

and 

 Sub-Bottom data = subsystem 0.  

All 3 types of data may be imported from this file. Seeing it all would mean 3 imported: 

(1) Sidescan import - choose channels 1 and 2 

(2) Sidescan import - choose channels 3 and 4 

(3) Sub-bottom import - choose channel 1. 
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2.5.2 One more issue - Small file JSF SS import - use SET FIRST N JSF = 0 

In versions 6.05.0009 and earlier, you may encounter difficulty importing sidescan data 
from a very small JSF files (e.g. one that contains 24 pings) . The issue may be that you 
have used a setting like SKIP FIRST N JSF = 1.  

 

In 6.05.0010 and later versions, the value 1 is ok even for very small files. For versions 
6.05.0009 and earlier, use SKIP FIRST N JSF = 0 for very small files.   

3 SonarWiz 6. 05 Version - JSF Bathymetry Import 

There are two major differences to note in JSF import for bathymetry, as opposed to 

sidescan, for example, which are described in the next sections 
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3.1 JSF Bathymetry Import - BINNED Files Required 

Your bathymetry files saved by DISCOVER may come in two categories, and the file 

types are revealed in the file name. where "stave" is in the file-name, these are raw-data 

type bathymetry recordings and they do not import well. Typically you would also save 

"binned" (filtered) files at the same time during survey, and these binned files are the 

ones to use in SonarWiz import for a bathymetry project. 

3.2 Minimum imported bathy JSF file - 50 pings 

This is not specific to the JSF file type, but please record at least 50 pings before trying 

to import it in SonarWiz as a bathymetry file, or an error message will occur. The error 

message may not say exactly that the minimum ping count = 50, but will refer to missing 

navigation and a minimum of 1 pings may be mentioned. For bathymetry, be sure you 

have at least 50 pings.  

4 SonarWiz 6.05 Versions - COLOR WINDOW and HISTOGRAM use 

This section explains how to use the 6.05-series SonarWiz versions to modify sidescan, 

bathymetry, or sub-bottom JSF data display, using the new COLOR WINDOW tool 

available in the map menu bar. 

 

4.1 SonarWiz earlier versions - COLOR WINDOW - Gradient-Legend Type 

SonarWiz 6.04 series, and earlier versions of SonarWiz, had display color, hue, 

brightness, and palette compression available at the top level of the SonarWiz GUI, like 

this: 
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4.2 Opening your COLOR WINDOW for use 

Since SonarWiz 6.05.0001, these available controls changed significantly. Note that the 

COLOR WINDOW button can be pressed in the MAP TOOL BAR, if yours is not 

showing, to enable the tool, and you can DOCK it left-side of your map-view: 



ImportingJSFFiles.PDF Chesapeake Technology, Inc. copyright 2016-2017 

Rev 14, 5/25/2016 support@chesapeaketech.com 650-967-2045 Page 23 
 

 

4.1 SonarWiz 6.05.0001++ - new HISTOGRAM type COLOR WINDOW 

In SonarWiz 6.05.0001 and later versions, the VIEW options for color control are gone 

from the GUI top, because the COLOR WINDOW (gradient legend) has radically 

changed for the better - with a HISTOGRAM control: 
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If you see NO HISTOGRAM AVAILABLE, chances are (like this demo GUI), the Data 

type selected in the COLOR WINDOW just does not match the data displayed in your 

map view. (Our says BATHYMETRY, but In this case it is a SIDESCAN project). So the 

first thing to do here is change the DATATYPE to Sidescan channels 1-2.: 
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This will result in a histogram-presentation representing a frequency-histogram display 

of the data values in your sidescan data: 
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Now you can change the way color maps to data values, by left-clicking and dragging 

the upper and lower limit bars in the histogram. Ours currently eliminates a majority 

(upper portion) of the data values, so we will move the upper limit UP to see a better 

view of the data: 
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Hover over the LIMIT BAR and it turns YELLOW: 

 

Releasing the left-click when the limit bar is where you want it makes it turn RED again 

and the data will be adjusted: 
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4.1 Tutorial Video - HISTOGRAM-type COLOR WINDOW Explained 

To see a recent Did You Know? type tutorial video explaining the COLOR WINDOW, 

and a few other recent sidescan enhancements in SonarWiz, here are a few viewing 

options: 

DYK SS Mosaic - New Options - 6.05.0001 - tutorial video (4 min 50 secs) 

(1) color window - histogram control design (time 0:00 - 1:14) 

(2) nadir replacement filter demonstration (time 1:15 - 2:57) 

(3) Grids -> Create Grid -> CSF Sidescan - new gridding option (time 2:58 - 4:50) 

https://www.youtube.com/watch?v=AHt4pftReHI&feature=youtu.be 

or ... 

MP4 download link: 

https://sonarwiz.box.com/s/8lu07vv6ccg3hvhfdzt4zhnkhm0l479q 

 

5 Document History 

Rev 14, 5/25/2016 - Updated with new information regarding data polarity choice in 

6.04.0001 and later, and FileTypeSpecificOptions to use in 6.05.0002 and later. 

Rev12, 2/27/2016 - Updated with new section 3 for COLOR WINDOW use practice with 

the new HISTOGRAM controls. 

Rev 9, 3/18/2016 - Recent improvements in JSF import described 
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